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ALOS 2 PALSAR 2 Data Calibration

°[dB] = 10log,o(DN)* + CF

oY — Radar Backscatter
DN — Pixel DN values

CF - Calibration Factor



1 Open QGIS installed on your computer

1.1 Goto Layer > Add Layer > Add Raster Layer
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2 Image Calibration

2.1 In Processing toolbox search bar type raster calculator.
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2.3 Input the Calibration
Expression here

2.5 Browse to the output folder
and give it a name and save it as
a .tif file

Q Raster Calculator

Parameters Log

Expression

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed

2.4 Click on this icon and select a

reference layer

[y—
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I . Il s I sin /| lgto || AND | according to an expression. The expression can
contain numerical values, operators and
I / i acos I asin || In i OR | references to any of the layers in the current
project. The following functions are also
ooset || tn f[ awn || ¢ || ) | supported:
‘ | = | ‘ - ‘ | 1= | | <= | ‘ . ‘ -sin(), cosQ, tan(, atan2(), In(), log100
The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
N layer(s) will be used. If the cell size is not spedified,
\_Bxression the mirimum cel size of selected reference layer(s)
will be used. If the output CRS is not specified, the
(207 log10{"MG-HH-ALO52221653250-180701-WBDR 1. 56GUD@17))-83 CRS of the first reference layer will be used.
The cell size is assumed to be the same in both X
and ¥ axes.
Layers are referred by their name as displayed in
the layer list and the number of the band to use
{based on 1), using the pattern layer_name @band
number', For instance, the first band from a layer
named DEM will be referred as DEM@1.
redefined s When using the calculator in the batch interface or
P == from the console, the files to use have to be
spedfied, The corresponding layers are referred
NDVL - | | add | save. using the base name of the file (without the full
path). For instance, if using a layer at pathjto/my/
rasterfile. tif, the firstband of that layer will be
Reference layer(s) (used for automated extent, cellsize, and CRS) [optional] referred as rasterfile. if@1.
|1 elements selected 11 .|
Cell size (use 0 or empty to set it automatically) [optional]
| 0.000000 a 2
Output extent (xmin, xmax, ymin, ymax) [optional]
| [Leave blank to use min covering extent] I
Output CRS [optional]
| Project CRS: EPSG: 102225 - MONREF_1997_UTM_Zone_47N MIE
Qutput
‘D:IZO 19/21_JIPTM_waorkshop/ResultsPre_Calib. tif | ‘
| Open output file after running algorithm
‘ 0% | Cancel
\Run as Batch Process | Run | | Close: | \ Help \ l
x| / [e] Multiple selection
* Raster calculator 1
o = 2.7 Click Run

v IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EP5G:102225]

X

| selectal |
| Clear Selection |
| Toggle Selection |

| AddFile(s

oK |

[
2.6ClickOK =7 e |




2.8 Do the same calibration for the post image

() Raster Calculator X

Parameters | Log | R calculator

ession
Express This algorithm allows performing algebraic
s Opes rs operations using raster layers.
The resulting layer will have its values computed
IMG-HH-AL0S2221653250-180701-WBDR1,5G6UD@1 | + I > I cos | sin || logo ||  awp | according to an expression. The expression can

IMG-HH-AL052225793250-180729-WEDR1.5GUD@1 contain numerical values, operators and
‘ s ‘ ‘ | ‘ ‘ acos | | asin | | In | | OR | references to any of the layers in the current

project, The following functions are also
Cc e e [ e [ [ | s.pporiec
-sin(), cos(), tan(), atan2(), In, log10()

The extent, cell size, and output CRS can be
defined by the user, If the extentis not specified,
the minimum extent that covers selected reference
layer(s) will be used. If the cell size is not spedfied,
the minimum cell size of selected reference layer(s)
will be used. If the output CRS is not spedified, the
Expression CRS of the first reference layer will be used.

(2050 10{TMG-HH-ALOS 2225793250~ 180725-WEDR 1. 56UD@17) - 83 Ths ;el\ size is assumed to be the same in both X
and Y axes.

Layers are referred by their name as displayed in

the layer list and the number of the band to use

{based on 1), using the pattern layer_name @band

number'. For instance, the first band from a layer

named DEM will be referred as DEM@1.

When using the calculator in the batch interface or
from the conscle, the files to use have to be
spedified. The corresponding layers are referred
using the base name of the file (without the full
path). For instance, if using a layer at path/fto/my/
Predefined expressions rasterfile. tif, the first band of that layer will be
referred as rasterfile. tif@1.

| novt | Add. || save

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

|1 elements selected | |:|

Cell size (use 0 or empty to set it automatically) [optional]

| 0.000000

Output extent (xmin, xmasx, ymin, ymax) [optional]

|[LEavE blank to use min covering extent] | |7|

Output CRS [optional]

| Project CRS: EPSG:102225 - MONREF_1957_UTM_Zane_47N M| |§|
Output
|D:J‘ZOJSJ‘ZlfJPTMiworkshoprEsuHs,’PostﬁCa\ib‘tf | |:|

Open output file after running algorithm

‘ 0% | Cancel

‘R.un as Batch Process .. l Run I | Close ‘ ‘ Help
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3 Speckle filterin

g

3.1 Type Despeckle in processing toolbox search bar Select the Despeckle in OTB toolbox.

3.2 Select the calibrated

pre-image fer

drop down.

3.3 Select the filter/

type as Lee

3.4 Specify radius of
the filter as 1 (3*3)

3.5 Browse to output
folder and give it a
relevant name and .tif
file type

@ Despeckle

Parameters Log
Input Image
" pre_calib [EPSG: 102225]
Spedkle filtering method
lee
Radius [optional]
1
Number of looks [optional]
1.000000
w Advanced parameters
Qutput pixel type [optional]
float

Output Image

Do the same process for the post image

Run as Batch Process...

D:/2019/21_JPTM_workshop/Results/Pre_Calib_Lee. tif

A ¥ Open output file after running algorithm

3.6 Click Run

Cancel

Run Close Help
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Images after speckle filtering
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4 Re-project images into WGS84 system

4.2 Select the filtered

pre-image from the
drop down. \

4.3 Select the Target
CRS as EPSG: 4326

4.4 Specify the
resampling as Nearest
neighbor

4.5 Browse to output
folder and give it a
relevant name and .tif
file type

4.1 Type Warp in processing toolbox search bar Select the Warp under GDAL

Processing Toolbox )
¥ a (O 2 S

P

Q Warp (Reproject)

Parameters Log
Input layer

" Pre_calib_Lee [EPSG:102225]
Source CRS [optional]

Target CRS
EPSG:4326 - WGS 84
Resampling method to use
Mearest neighbour
Nodata value for output bands [optional]
Mot set
Output file resolution in target georeferenced units [optional]
Mot set
p Advanced parameters
Reprojected
D:/2019/21_1PTM_workshop/Mew/Pre_Calib_Lee_Prj.tif

+ | Open output file after running algorithm

GDAL/OGR. console call

L warp
\ - Recently used

T Warp (reproject)
= (2 Vector general
45 Assign projection
45 Reproject layer
o GDAL
* Raster extraction
% Clip raster by mask layer
* Raster projections
W Warp (reproject)
~ & SAGA
~ Georeferencing
6 Warping shapes

4

gdalwarp -t_srs EPSG:4326 + near -of GTiff D:/2019/21_1PTM_workshop/Results/Pre_Calib_Lee. tif D:/2019/21_JPTM_workshop/MewPre_Calib_Lee_Prij. tif

Run as Batch Process...

4.6 Click Run

0% Cance

Run | Close Help

Do the same process for the post filtered image
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5 Generating the pre-post difference image

5.1 Type Raster calculator in processing toolbox search bar Select the Raster calculator under QGIS tools

5.2 Obtain the difference b

etween projected pre and post

images by Inputting the
Expression as follows

5.3 Browse to the output
folder and give it a name
and save it as a .tif file

(2 Raster Calculator

Parameters Log

Expression
Layers
Output
Post_Calib_Lee
Post_Calib_Lee_Prj
Pre_Calib_Lee

Pre_Calib_Lee_Prj

Expression

“Post_Calib_Lee_Prj@1" - "Pre_Calb_Lee_Pri@1”

Predefined expressions

MDVI

Reference layer(s) {used for automated extent, cellsize, and CRS) [optional]
2 elements selected
Cell size (use 0 or empty to setit automatically) [optional]

0.000000
Output extent (xmin, xmax, ymin, ymax) [optional]

[Leave blank to use min covering extent]

Output CRS [optional]

Output
B D:/201/21_TPTM_workshopNew/Change _img. tif

| Open output file after running algorithm

Run as Batch Process

Operators

0%

sin log10 AND
asin In OR
atan ( )
1= <= =
- Add... Save..
a |-

named DEM u#tbe referred as DEM@1.
A using the ca\cﬁgﬁﬁ\r;&rc]\c@fajarye
from the console, the files to use have to be

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed
according to an expression. The expression can
contain numerical values, operators and
references to any of the layers in the current
project. The following functions are also
supported:

-sin(), cos(), tan(), atan2(), InQ), log 100

The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
Iayer(s) will be used. IF the cell size is not specified,
the minimum cel size of selected reference layer(s)
will be used. If the output CRS is not specified, the
CRS of the first reference layer will be used.

The cell size is assumed to be the same in both X
and Y axes,

Layers are referred by their name as displayed in
the layer list and the number of the band to use

S SdClickianth

spedified. The corresponding layers are referred

is icon and select a

4

-

using the base name of the file (withoyse==all

path). For instance, if using a layer at| Multiple selection

rasterfile. if, the first band of that lays
referred as rasterfile. tf@1.

Post_Call

Run | Close |

/

5.6 Click Run

JPTM 2019

IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALOS2225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EPSG:102225]

Post_Calib_Lee_Proj [EP5G:32647]

ib [EPSG:102225]

Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]
V| Pre_Calib_Lee_Proj [EPSG:32647]

5.5 Click OK

Select Al
Clear Selection
Toggle Selection

Add File(s)
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Change Image after raster calculation

(2 *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web
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6 RGB visualization of post and pre-images

6.1 Goto Raster > Miscellaneous > Build virtual raster

() Build Virtual Raster

6.2 Click this icon and select the Pre-Processed, pre and post images from this tab

\

Parameters | Log

Input layers

2 clements selected
Resolution

average

V| Place each input file into a separate band

Allow projection difference
v Advanced parameters
Add alpha mask band to YRT when source raster has none
Override projection for the output file [optional]

Resampling algorithm

nearest

Nodata value(s) for input bands (space separated) [optional]

Virtual
[Save to temporary fie]

| Gpen output file after running algorithm

GDAL/OGR. console cal

Run as Batch Process.

gdalbuildvrt resolution average -separate + nearest -input_file_list C:/Users/Chatumal/AppData/Local/Temp/processing_3a8ch347677f4af48a922a7 12ecfadéc/a0 1f7a54808 14920b796a6daeae 361 1cbuildvrtinputFiles. tt C:/Users/Chatumal fAppData/Local/Temp/processing_3aBch347677f4af48a922a7 12ecfadsc/
cfee45feb6954213b076f94187d32ba2/OUTPUT. vt

Cancel

-
K
5

Close Help

Q Multiple selection

Change_img [EP5G:32647]
Output [EPSG:32647]
IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EPSG:102225]

v Pre_Calib_Lee_Proj [EPSG:32647]
Post_Calib_Lee_Proj [EP5G:32647]

Post_Calib [EPSG:102225]
Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]
RGE [EP5G:32647]

ok W

Select Al
Clear Selection
Toggle Selection

Add File(s)...

Cancel

AN

6.3 Click OK

6.4 Click Run.

JPTM 2019
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6.5 Right click on the created virtual band and select Properties > Symbology

Q@ "qgs36-QGS
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Red Band

Blue Band

- d X
6.6 Select band 1(pre), band 2(post) from the dropdowns as follows
@ Layer Properties - RGB | Symbology
w Band Rendering
] ocessing Toolbox a8 Render type | Multiband color -
ETNE
AR Redband | Band -
A a Min |-22.2567 | Max |-2.8801
) Recenty used 4 e "
Y i— Greenband |Band 2 -
v & oA Min |-23.8757 | Max |-2.5643 |
> G Bueband  |Band2 ]
e =
F pCTtoRGe
5. RGB1oPCT Min |-23.8757 | Max |2.5643 |
¥ f:s;’ T Contiast | cyreten to MinMax -
@ icolorsenhance
i e e, et
Resats Viewer B8
B Min [ Max Value Settings
w Color Rendering
Blending mode | Normal - | # Reset |
arightness O [0 [2]] contrast O b |5
Saturation ] lo :M Grayscale | OFf ~|
Hue Colorize - strength ) [100% <]
| Kenty Results 8% ¥ Resampling
3 5. Zoomed:in | Nearestneichbour ~ | out | Nearest neighbour ~ | Oversamping (200 |3
§ Feature ke Thumbnail Legend Palette
| stk | ok || Cancel || Aply || Hep
Yade | Topdown v Auto ogen fom
15 e |
53 | v @ Ve 0% ot 000 5 VRedy Socinns @

The areas likely to be flooded will appear as red, under this particular band combination. Observing change image and this RGB visualization,
you can find the radar backscatter value range in the flood region. A threshold value can be selected for delineate the flood extent.
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7 thresholding the Pre, Post difference image

7.1 Input Expression as follows (threshold value for detected water selected as -3 here)

Q Raster Calculator

Parameters | Log

Expression
Layers Operators

Change_img@1 + =

Post_Calib_Lee Prj@1

Post_Calib_Lee@1 S /

Pre_Calib_Lee@1

Pre_Calib_Lee_Prj@1 ~ =3
< >

Expression

“Change_img@1" < -3

Predefined expressions

MNDVT

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]
1 elements selected

Cell size (use 0 or empty to set it automatically) [optional]
0.000000

Output extent (xmin, xmax, ymin, ymax) [optional]
[Leave blank to use min covering extent]

Output CRS [optional]

Output
D:/2019/21_IFTM_workshop/Mew /Change_img_tresh, tif
f v Open output file after running algorithm

Run as Batch Process...

0%

log10 AND
In OR

( )
<= >=

Raster calculator

This algorithm allows performing algebraic
operations using raster layers.

The resulting layer will have its values computed
according to an expression. The expression can
contain numerical values, operators and
references to any of the layers in the current
project. The folowing functions are also
supported:

-sin{), cos(), tan(), atan2{), In{), log10()

The extent, cell size, and output CRS can be
defined by the user. If the extent is not specified,
the minimum extent that covers selected reference
layer(s) will be used, If the cell size is not specified,
the minimum cel size of selected reference layer(s)
will be used. If the output CRS is not spedified, the
CRS of the first reference layer will be used.

The cell size is assumed to be the same in both X
and Y axes,

Layers are referred by their name as displayed in
the layer list and the number of the band to use
(based on 1), using the pattern layer_name:
number'. For instance, the first band layer
Save, named DEM will be referred 5
When using Filator in the batch interface or
om, nsole, the files to use have to be
tified. The corresponding layers are referred
using the base name of the file (without the full
path). For instance, if using a layer at path/to/my/
rasterfile. tif, the first band of that layer will be

a |- referred as rasterfile. if@1.
<[
| Run | Close

7.4 Browse to the output folder and give it a name and save it as a .tif file

JPTM 2019

7.5 Click Run

7.2 Click on this icon and select a

_— reference layer 3§

Q Multiple selection

V| Change_img [EP5G:32647]
Output [EPSG:32647]
IMG-HH-ALOS2221653250-180701-WBDR1.5GUD [EPSG:102225]
IMG-HH-ALO52225793250-180729-WBDR1.5GUD [EPSG:102225]
Post_Calib_Lee [EP5G:102225]
Post_Calib_Lee_Proj [EPSG:32647]
Post_Calib [EPSG:102225]
Pre_Calib [EP5G:102225]
Pre_Calib_Lee [EP5G:102225]

Pre_Calib_Lee_Proj [EP5G:32647]
RGE [EP5G:32647]

7.3 Click OK

Select All
Clear Selection
Toggle Selection
Add File(s)...

| oK

Cancel
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Change Image after thresholding
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8 Converting the data type of the threshold image

8.1 Type Translate in processing toolbox search bar and select the Translate(convert format) under GDAL

Processing Toolbox 5]
*@_ L NON= %
. L Transla
8.2 Select the threshold image from the drop down. - E\ Veczmeatim

- Array of translated features

() Translate (Convert Format) x = 2 Vector geometry

4 Translate
-
Parameters | Log i GDAL .
~ Raster conversion
ol %, Rearrange bands
8 3 I. k d d 2 Change_img_tresh [EPSG:4326] M= «~ Translate (convert format)
* click on advance Override the projection for the output file [optional] ~ Raster extraction
~ B Clip raster by extent

parameters

Assign a specified nodata value to output bands [optional]
Naot set

\ Copy all subdatasets of this file to individual output fles
w Advanced parameters

Additional creation options [optional]

Profile | Default

Name Value

8.4 Change the output | (& = s |
datatype as byte T, M -

Byte

Converted
D:/2019/21_PTM_workshop/New/Change_img_tresh_int.tif

/ V| Open output file after running algorithm

GDALOGR. console call

8.5 Browse to t h € gdal_transiate -ot Byte -of GTifF D:\2018121_IPTM_workshop'lew\Change _img_iresh. if D:/2018/21_JPTM _workshop/New/Change_img_tresh_int.tF
output folder and

give it a name and
save it as a .tif file 8.6 Click Run

[ ” /

Run | Close

Run as Batch Process
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9 Application of majority filter to reduce the noise pixels

9.2 Select the t

hreshold image (Byte) from the drop down.

9.1 Type Majority in processing toolbox search bar and select the Majority filter under SAGA

Processing Toelbox

"'gt' .'.l- L) "

majority|

& Majority Filter
Parameters | Log
Grid

9 3 I n p Ut ra d i us ¥ Change_img_tresh_int [EPSG:4326]

Search Mode:

as 3 (5*5) \ [0] Square

3
Threshold [Percent]
0
Filtered Grid

D:2019/21_IPTM_workshop/New [Change_img_tresh_int_maj.sdat

A V| Gpen output fil after running algorithm
9.4 Browse Ae output folder

and give it a nam
a .sdat file

e and save it as

Run as Batch Process.

= ) Vector analysis

< 7, Basic statistics for fields
7. Statistics by categories

v ) Vector general

7. loin attributes by locatign (summary)
~ & SAGA
* Raster filter

& Majority filter

9.5 Click Run

/

R
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* Raster filter
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9.6 Right click on the majority filtered image> Properties

() Layer Properties - Change_img_thresh_int_maj | Symbalogy X
.
9.7 select symbology and under render type select unique values 3 _
w Band Rendering
(3 Informatio
2 Information Render type | Paletted/Unique values ~
Q Layer Properties - Change_img_thresh_int_maj | Symbology x a
— o \:\_- Source Band Band 1 T
- M e . imca
Multiband color Color ramp Random colors =
"i Information Render type R s S
Uniqueivalues Value Color Label
J\:\‘ Source - Singleband gray - l_a Transparency
= Singleband pseudocalor o 0
& Symbolagy Colorramp || piishade Random colors M gram
— T - : B
Iﬂ Transparency i Rendering
’
& Rendering
Bl vetsda & aais server
.
Legend
L 9.3 Click lassif
. IC on C aSSI y Classify oh | (= Delete All i
/ w Color Rendering
Classify = Delete All -
' Blending mode | Normal - 4 Reset
w Color Rendering Brightrx L3 0 v IConhast S —_F 0 =
Blending mode | Normal - 4> Reset Saturation —F 0 * IGrEYEG‘E off M
Brightness S | a0 = [Cmt,ast — 0 - Hue Colorize Strength ) | 100%
Saturation —— 1] = [ Grayscale | Off - v Resampling
Hue Colorize Strength _l | 100%
Zoomed: in | Mearest neighbour ~ | out | Mearestneighbour ~ | Oversampling | 2.00 |
w Resampling
Thumbnail Legend Palette
Zoomed: in | Nearest neighbour ~ | out | Nearest neighbour ¥ | Oversampling | 2.00 |5
Thumbnail Legend Palette
Style = ‘ oK ‘ Cancel Apply Help
Style oK Cancel Apply Help /

9.8 Click OK
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Classified image ( water-1, non water-0)

Q@ et s Lo 9.10 Set the format as Geotiff 9.11 Browse to the output folder
e YT T TTY Y Y . iy m. o and give it a name and save it as a
NERRERY P*2LSR PR LBEAL &6 K o-f- c@MIB-PE- / .ff.flg
sevse TTEE “aBatsn QAR 40 B tiffile  /
b ( Save Raster Layer as... X
Browser Processing Toolbox =1
e ®e085 % Outputmode (® Rawdata ed image
e O, magrty al =
g N Fomat | GeoTIFF / ~ | [ create T
» ~ @ Vectar analysis ‘ /)
- s Flename  |D:\2019\21_JPTM_workshop\New\Detected_Flood. tif all.]
Statsics by categories
) Qmmlnswm[mmmm Layer name ’ |
" S RS | EPSG:4326 - WGS 84 - ][]
€ Mty i =
'V Add saved file to map
ety Rt 28 | CurentlayerExtent | |CalulatefromLayer ~| |  MapCanvasExtent | [
LR LY
» w Resolution (current: layer) |
B Zouma NoteRescttion (002 (®) Horizontal |0.000231137 | Vertical |0.000231137 | |Layer Resolution |
gi::,:;wm () Columns | 17409 | Rows | 16742 [| Layersize
L Bemove Layer..
‘Set Layer Scale Visiility...
s D V Create Options
»  Pyramids
w V| Nodata values
T epe— ET— From To
Q Type tolcate (Ch) Coodrate 53.005,15.397 B s 1SR v @ Mege 100% 2 Romn (000 |3 ViRedw Smscas @ <] | >
H=EE |
9.13 type O /
9.9 Right click on the classified image > Export here I x || cancel || o |
> Save As / \

9.14 click OK
9.12 Add the no data value as 0 by click on this icon
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10.2 Selec

10 Conversion the Detected Flood raster file into a vector file

10.1 Type polygonize in processing toolbox search bar and select the Polygonize under GDAL

t the Detected flood raster fromye drop down.

10.3 Brow
and give it
.shp file

(! Polygonize (Raster to Vector)

Parameters Log
Input layer

¥ Detected_Flood [EPSG:4326]
Band number

Band 1 (Gray)
Name of the field to areate

DN

Use 8-connectedness

Vectorized

D:/2019/21_PTM_warkshop New/Detected_water Flood.shp

v Open output file after running algorithm

se to the output folder
a name and saveit as a

GDAL/OGR console call

python3 -m gdal_polygonize D:\2019\21_JPTM_workshop'New'Detected_Flood. if D:/2018/21_JFTM_workshop/New/Detected_water/Flood.shp -b 1 f "ESRI Shapefile” Flood DN

0%

Run as Batch Process...

JPTM 2019

Cancel

Run Close Help

Processing Toolbox ]
# A (O

L polygaonize
Recently used
4 Polygonize (raster to vector)
* () Vector creation

- Raster pixels to points

- Raster pixels te polygons
* () Vector geometry

& Polygonize
v o GDAL
* Raster conversion

4 Polygonize (raster to vector)

24



Detected Flood in Vector format
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» [0 6\ 4 Export to PostgreSQL
» JvA 4 Export to Spatialite
» [ XA [ 4 PostgreSQL execute and load SQL
» OvA % PostgreSQL execute SQL
» Oz ~ @ Graphics
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To make Value Added Product more informative, you can combine OSM data with these processed product.
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Value added products after combined with more information

FLOODING IN BAGO DIVISION, MYANMAR

!)l-h II\lH‘

e

As observed by ALOS-2 image on 29 July 2018
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FLOODING IN BAGO AND MON DIVISION, MYANMAR
As observed by ALOS-2 image on 29 July 2018
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Datum: D WGS 84
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- Flood Proxy Map
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Satellite image:

Pre-disaster : ALOS-2, 1 July 2018
Post-disaster : ALOS-2, 29 July 2018
Copyright : © JAXA (2018) - All rights reserved.
GIS data:

River, Water bodies © OSM 2018
Administrative boundary ©® GADM

Service Layer Credits: Sources: Esri, HERE, DeLorme,
Intermap, increment P Corp., GEBCO, USGS, FAO,

This map shows possible massive flooding areas from
heavy rain on 27 July 2018, which has affected Bago

and Mon Division, Myanmar. Note that the detected-water
may also include water in paddy area.
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Map product made by GIC-AIT (v1.0).
Disclaimer: The accuracy of this product is not validated.

Data provider: !
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Useful links:

OSM Data Download :  https://download.geofabrik.de/

Marine region shape file Download : http://www.marineregions.org/gazetteer.php?p=details&id=1904

Thank You!
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